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Glossary
Table 1 Glossary

Description

Acronym

CACFP
FBG
FNS
PFS
RAW
SFP
USDA

Child and Adult Care Food Program
Food Buying Guide
Food and Nutrition Service
Product Formulation Statement
Recipe Analysis Workbook
Supplemental Food Program
U.S. Department of Agriculture

Food Buying Guide (FBG) – User Guide

December 11, 2020

Page 5

FNS User Manual - FBG

1

Introduction

The Food and Nutrition Service (FNS), an agency of the U.S. Department of Agriculture
(USDA), has a responsibility to ensure that school nutrition professionals have the necessary
knowledge to plan, purchase, prepare, and serve nourishing meals that meet Federal meal pattern
requirements and meet the operational needs of school districts. The Web-based Food Buying
Guide (FBG) allows for easier searching, navigating, and displaying of key information for food
items.
The USDA FBG is an essential tool used to assist in:
1. purchasing the right amount of food and purchasing it most economically, and
2. determining the specific contribution each food makes toward the meal pattern
requirements to ensure that meals provide necessary nourishment and meet program
requirements for reimbursement.
In addition, with yield data for more than 2,200 food items, this guide can provide ideas for
adding new foods or new forms of familiar foods to the menus. The FBG is widely used by
school food service professionals participating in the National School Lunch Program and
School Breakfast Program. It is also appropriate for use in the Child and Adult Care Food
Program as well as the Summer Food Service Program.

1.1

Accessibility

All reports (e.g., Yield Data, Compare Food Items, Food Item Detail, Product Formulation
Statement, and Recipe Analysis Workbook) on the FBG tool can be printed (as PDF) or exported
and saved in the |-delimited formats that can then be imported into Microsoft Excel. If you have
trouble accessing, printing, and saving any of these reports, and would like to request them in
alternative formats, please send your assistance request to CNPNTAB@usda.gov and you will
receive a response within 48-business hours.
Please send any questions or report website accessibility problems to CNPNTAB@usda.gov via
email or using the Contact Us feature of the application (as described in section 2.4.6.3). In your
message, include the page address or URL and the specific problems you have encountered.

1.1.1

Keyboard Navigation

The FBG application can be navigated without a mouse using the keyboard only. Use the
following shortcuts to navigate FBG screens:
•

•

Menus:
o Tab to move between items in the main menu
o Enter to open a menu
o Up and Down Arrows to move between sub-menus
o Enter to open a sub-menu
Accordions:
o Up and Down Arrows to move between accordions
o Enter to open an accordion
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•
•
•
•
•
•
•

•

•

o Enter to collapse an accordion
o Tab to move down within accordion body
o Shift + Tab to move up within accordion body
o Shift + Tab to move up from accordion body to the accordion header
Text Fields:
o Tab into a text field, type in a value, then Tab to the next control
Drop-downs:
o Tab into a drop-down and use Up and Down Arrows to select a value, then Tab
to the next control
Radio Buttons:
o Tab into a radio button group and use Left and Right Arrows to select a value,
then Tab to the next control
Buttons:
o Tab onto a button, then press Enter to activate it
Links:
o Tab onto a link, then press Enter to activate it
Tooltips:
o Tab onto a tooltip anchor (“i” in a circle) to bring up the tooltip bubble with text
o Tab off a tooltip anchor to close the tooltip bubble with text
Pagination Controls:
o Tab between page number buttons
o Enter on page number button to display the corresponding page
o Enter on First, Last, Next, and Previous buttons to display the corresponding page
Tools – PFS and RAW, Meal Component Tabs:
o Left and Right Arrows to move between tabs
o Tab to go into meal component tab body
o Tab to move between controls in the meal component tab body
o Shift + Tab to move backwards between controls in the meal component tab body
o Shift + Tab to move up from meal component tab body onto the meal component
tab header
Video Player:
o Tab onto the video player, then
o Tab onto the main Play button that overlays the video, then
o Tab to video player controls
o Tab to move between video player controls
o Shift + Tab to move backwards between video player controls
o Enter to press the Play buttons
o Tab onto the Progress Bar and use Left and Right Arrows to scroll, Tab off
o Tab onto the Caption Control and use Up and Down Arrows to choose None or a
Language, Tab off
o Tab onto the Full Screen Control and use Enter to activate full screen mode,
Escape to exit
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1.2

Overview

1.2.1

Key Information

Site URL: https://foodbuyingguide.fns.usda.gov

1.2.2

User Groups

FBG has three main user groups: Guest User, Registered User, and Administrator User. Each
user can belong to one Organization Type: FNS National Office, FNS Regional Office, Vendor,
State Agency, School, Child Care, and Other. Functionality available to each user depends on
his user group and Organization Type.
•

Guest Users: Public users can access key components of the FBG through the Internet
without providing login credentials or creating a user account. Guest users can search and
view Food Items, create a Favorites list, and use FBG Calculator. However, the Favorites
list and FBG Calculator Shopping Lists will only remain active while the user is actively
using the FBG site. If the user closes the FBG site and returns to it, the Favorites list and
Shopping Lists will not be saved.

Table 1: Guest User Permissions per Organization Type

Organization

Textonly
screens

Search

Favorit
es

FBG
Calculator

Exhibit
A Grains
Tool

FNS National
Office, FNS
Regional Office

x

x

x*

x*

x*

Vendor

x

x

x*

x*

x*

State Agency,
School, Child
Care, Other

x

x

x*

x*

x*

RAW

PFS

Admin
Features

* - Functionality is available but will only be persistent during user’s browser session.

•

Registered Users: Registered users are logged in to the FBG site using their
eAuthentication credentials. Using the FBG site as a registered user gives the user extra
capabilities, such as:
o save the generated Favorites list and FBG Calculator Shopping Lists;
o analyze recipes (Recipe Analysis Workbook functionality) and save them;
o for manufacturers, ability to create and save Product Formulation Statements.
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Table 2: Registered User Permissions per Organization Type

Organization

Textonly
screens

Search

FNS National
Office, FNS
Regional Office

x

x

x

x

x

Vendor

x

x

x

x

x

State Agency,
School, Child
Care, Other

x

x

x

x

x

•

FBG
Favorites Calculator

Exhibit
A Grains
Tool

RAW PFS

x

Admin
Features

x

x

x

Administrator: Site Administrators have elevated privileges within the application, and
in addition to all functionality available to registered users, can add food items to the
database and perform minor user administration activities.

Table 3: Administrator User Permissions per Organization Type

Organization

FNS National
Office

Textonly
screens

Search

Favorites

x

x

x
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2

Guest User

2.1

Logging In

When navigating to the FBG URL, a User will first see the following Login Screen:
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To continue as a Guest User, select an “Organization Type” from the dropdown menu and click
“Enter.” Different subsets of functionality will be available depending in the “Organization
Type” selected.

2.2

FBG Home Screen

From the main FBG Home Screen, the Guest Users can use the top navigation links and main
screen buttons to access information.
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The links found in the top navigation of the Home Screen stay consistent throughout the
application. Different subsets of functionality will be available depending in the Organization
Type selected. The functions associated with each top navigation option are further described in
section 2.4.

2.3

Home Screen Buttons

2.3.1

Food Items Search

Click the “Food Items Search” button:

On the Search Food Items Screen, the users can search food items by using several search
criteria. To clear selected criteria, the users can click “Reset Search.”
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2.3.1.1

Search by Keyword

In the “Keyword” text box, type in a keyword and click the “Search” button.

2.3.1.2

Search by Meal Component

Users can also search for food items using the “Meal Component” dropdown options. To initiate
a search using these search characteristics, the user fills in different fields on the same screen
previously described for the keyword search.
In the “Meal Component” dropdown menu, select a meal component and click the “Search”
button.

2.3.1.3

Search by Category

Users can use the “Category” dropdown menu to further filter the component selected in the
“Meal Component” dropdown. To search by category, select a meal component from the
dropdown list, select a category from the dropdown list, and click the “Search” button.
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2.3.1.4

Using the Search Results

Once the user clicks “Search,” the screen will display the search results according to the criteria
selected.

Information displayed for each food item is:
•
•
•
•
•
•
•
•

Meal Component
Meal Category and Subcategory
Food As Purchased, AP
Purchase Unit
Servings per Purchase Unit, EP
Serving Size per Meal Contribution
Add to Compare link – allows to add up to four items to be compared
Add to Favorites link – adds the food item to Favorites
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NOTE: Footnotes for Meal Component, Food Category, Subcategory and Food As Purchased,
AP will be shown in Search Results when available. Click on the corresponding Footnote link to
view footnote(s).
2.3.1.5

Search Results – View Food Item Details

To view information about a specific food item, click the blue link of the food item name in the
“Food As Purchased, AP” column.
The following food item information will be displayed on Food Item Details Screen:
•
•
•
•
•
•
•
•
•

Meal Component
Meal Category
Meal Subcategory
Food As Purchased, AP
Purchase Unit
Servings per Purchase Unit, EP
Serving Size per Meal Contribution
Purchase Units for 100 Servings
Footnotes

From this screen, the user has the following options:
•

The “View PDF” button opens a PDF that contains all information on Food Item Details
screen. The PDF can then be saved or printed.

•

The “Export” button opens a text file that contains all information on Food Item Details
screen except Footnotes. The text file is delimited by “|” character and can be imported
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into Microsoft Excel. The file can also be opened in Excel. See section 2.6 for more
information.
•

The “Add to Favorites” / “Remove from Favorites” button adds (or removes) the selected
food item to the user’s Favorites list.
o NOTE: For Guest Users, this Favorites list will only be generated and remain
active while the user is actively using the FBG site. If the user closes the FBG site
and returns to it, the Favorites list will not be saved.

•

The “Close” button takes the user back to the Search Food Items Screen.

2.3.1.6

Search Results – Add Food Item to Favorites

To add food items to Favorites, click on the “Add” link of the “Add to Favorites” column of the
Search Results table.

You can remove a food item from Favorites from the Favorites screen, or you can click on the
“Remove” link of the “Add to Favorites” column of the Search Results table. For more
information see section 2.3.2.
2.3.1.7

Search Results – Add Food Item to Compare Items

To compare food items, click on the “Add” link of the “Add to Compare” column of the Search
Results table.

The food item will then appear in the “Food Items Selected for Comparison” section of the
Search screen. The corresponding rows in the Search Results table will no longer have the “Add”
link in the “Add to Compare” column.
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You can add up to 4 food items to compare while navigating multiple pages of search results, or
after performing a different search. Food items can be removed from the “Compare” list using
the corresponding “Remove” links in the “Food Items Selected for Comparison” table. You can
also clear all Compare items using the “Clear All” button.

Press “Compare Items” button to view full detail for the food items being compared on
“Compare Items” screen.
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From this screen, the user has the following options:
•

The “View PDF” button opens a PDF that contains all information on Compare Items
screen. The PDF can then be saved or printed.

•

The “Export” button opens a text file that contains all information on Compare Items
screen except Footnotes. The text file is delimited by “|” character and can be imported
into Microsoft Excel. See section 2.6 for more information.

•

The “Return to Search” button takes the user back to the Search Food Items screen.

2.3.2

Food Item Favorites

Click the “Food Item Favorites” button:

On the Favorites List Screen, the users can view food items they marked as Favorites:

From this screen, the user has the following options:
•

The “View PDF” button opens a PDF that contains all information on Favorites List
screen. The PDF can then be saved or printed.

•

The “Export” button opens a text file that contains all information on Favorites List
screen except Footnotes. The text file is delimited by “|” character and can be imported
into Microsoft Excel. See section 2.6 for more information.

To remove an item from the Favorites list, click “Remove” link in the “Remove from Favorites”
column of the Favorites list table.
NOTE: For Guest Users, the Favorites list is not retained once they navigate away from
the FBG Web site.
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2.3.3

Download Food Buying Guide

Click on the “Download Food Buying Guide” button to open the Download Food Buying Guide
screen:

Download Food Buying Guide screen contains links to the Food Buying Guide Introduction, six
Meal Component sections with the corresponding Yield Tables, and Appendixes in PDF format.
Last updated date is listed for each Yield Table. Click on each link to open the corresponding
document.

2.3.4

Exhibit A Grains Tool

Exhibit A Grains Tool functionality is activated by the “Exhibit A Grains Tool” button. Please
see section 2.5.1, Exhibit A Grains Tool for more information.

2.3.5

FBG Calculator

FBG Calculator functionality is activated by the “FBG Calculator” button. Please see section
2.5.2, FBG Calculator for more information.
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2.3.6

Product Formulation Statement (PFS)

PFS functionality is activated by the “Product Formulation Statement (PFS)” button. Please see
section 3.2.2, Product Formulation Statement (PFS) for more information.

NOTE: This functionality is not available to Guest Users, please create an account to
access it. This functionality is available to Authenticated Users with selected
Organization of “Vendor,” “FNS National Office,” or “FNS Regional Office”.

2.3.7

Recipe Analysis Workbook (RAW)

RAW functionality is activated by the “Recipe Analysis Workbook (RAW)” button. Please see
section 3.2.1, Recipe Analysis Workbook (RAW) for more information.

NOTE: This functionality is not available to Guest Users, please create an account to
access it. This functionality is available to Authenticated Users with selected
Organization other than Vendor.

2.3.8

View Meal Component Information

To view information about Meal Components, click on the corresponding meal component
image on the Home screen:

The image button directs the user to an informational screen about that Meal Component.
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To view information under the sub-headings on the screen, click on the grey heading bar (i.e.,
“Optional Best Practices for All Child Nutrition Programs” or “Definitions”) to expand the
section.
From this screen, the user has the following options:
•

Search meal component food items – the “Search” button takes the user to the Search
Items screen with the “Meal Component” control pre-populated with the meal component
being viewed.

•

The “View Yield Table PDF” button opens a PDF view of the selected meal component’s
yield tables. The PDF can then be saved or printed.

•

The “Export Yield Table” button opens a text file that contains all information for meal
component’s yield table except Footnotes. The text file is delimited by “|” character and
can be imported into Microsoft Excel. See section 2.6 for more information.

Users can use the steps outlined above to access information about each of the Meal
Components.

2.4

Top Navigation Menus

In addition to navigating through FBG from the main screen, users can use the Top Navigation
menus to access functionality within the site.

2.4.1

Home
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2.4.1.1

Home Page

From the “Home” dropdown menu, users can view FBG Home Page screen (described in section
2.2 above) by selecting the “Home Page” menu item.
2.4.1.2

What’s New

From the “Home” dropdown menu, users can view the list of announcements by the FNS staff by
selecting the “What’s New” menu item. This menu item opens What’s New screen that lists
announcements that are currently active, if any.

2.4.1.3

About the Food Buying Guide

From the “Home” dropdown menu, users can view the About the Food Buying Guide screen by
selecting the “About the Food Buying Guide” menu item.

2.4.1.4

Download Food Buying Guide

From the “Home” dropdown menu, users can view the Download Food Buying Guide screen by
selecting the “Download Food Buying Guide” menu item.
2.4.1.5

Resource Center

From the “Home” dropdown menu, users can view the About the Food Buying Guide screen by
selecting the “Resource Center” menu item. Resource Center screen provides the user with the
Food Buying Guide (FBG) – User Guide
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Child Nutrition Programs Meal Pattern charts and reference tables and figures (i.e. Decimal
Weight Equivalent table) to support information found in the Food Buying Guide. By clicking on
the blue links, the users can access a PDF document of the information.

2.4.2

Meal Components

From the “Meal Components” dropdown menu, users can select an individual meal component
to view more information specific to that meal component.
The users can navigate through the information following the same process outlined in section
2.4.1.

2.4.3

Food Items

2.4.3.1

Search

From the “Food Items” dropdown menu, users can select “Search” menu item to reach the
Search Food Items screen and search through food items following the same process outlined in
section 2.3.1.
2.4.3.2

Favorites

From the “Food Items” dropdown menu, users can select “Favorites” menu item to reach the
Favorites List screen. See Section 2.3.2 for more information.
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2.4.4

Tools

From the “Tools” dropdown menu, users can access the following:
The Tools top navigation menu provides the user with the following options:
•
•
•
•
•
•
•
•
•
•
•

2.4.5

My RAW Recipe List – list of user’s RAW (functionality is not available to guest users)
Create RAW – create RAW (functionality is not available to guest users)
My PFS List – list of user’s PFS (functionality is not available to guest users)
Create PFS for School Meals (functionality is not available to guest users)
Create PFS for Other CN Programs (functionality is not available to guest users)
FBG Calculator - My Shopping Lists – list of user’s Shopping Lists (Shopping Lists are
persistent only while user is active in the FBG application)
FBG Calculator - Create Shopping List – create a Shopping Lists (Shopping Lists are
persistent only while user is active in the FBG application)
Exhibit A Grains Tool - My Products – list of user’s Products (Products are persistent
only while user is active in the FBG application)
Exhibit A Grains Tool - Enter Product – enter a Product (Products are persistent only
while user is active in the FBG application)
Determining Creditable Grains/Breads – an interactive chart
Does My Product Meet the Grain-Rich Criteria? – an interactive chart

Appendixes

From the “Appendixes” dropdown menu, users can access more information about specific items
related to the Food Buying Guide for Child Nutrition Programs.
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2.4.6

Help

2.4.6.1

User Guide

From the “Help” dropdown menu, users can view access-level-appropriate User Guide in PDF
format by selecting the “User Guide” menu item.
Please contact FNS though the Contact Us menu item (described below) or by emailing to
CNPNTAB@usda.gov request the user guide in another format.
2.4.6.2

Training Video

The Training Video screen contains a video player that displays the FBG training video. The
first chapter of the training video is displayed in the video player automatically. Click on a link
for each chapter for it to appear in the video player. Click on the link for Training Video
Transcript to view the transcript of the video in PDF format.
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2.4.6.3

Contact Us

From the “Help” dropdown menu, users can contact FNS team via email by selecting the
“Contact Us” menu item. This menu item opens the Contact Us screen with a form:

On the Contact Us screen, fill in the following fields:
Table 4: Contact Us form fields

Field Name

Description

Title (required)

Title for your email

Message (required)

Body of your email

Your Name

Enter your name, so FNS staff can contact you if needed

Email (required)

Enter your email, so FNS staff can contact you if needed

Phone Number

Enter your phone number, so FNS staff can contact you if needed

Accessibility or
Section 508-related
Inquiry

Check this checkbox if you are contacting FNS regarding the
application accessibility or a Section 508-related issue or inquiry.
Checking this checkbox will alert FNS staff of nature of your request
for faster processing.
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From this screen, the user has the following options:
•

Send the email message to CNPNTAB@usda.gov using “Send Message” button. If this
option is selected, the email is sent, and the user is shown a conformation message.

•

Cancel the action using the “Cancel” button.

2.4.6.4

Frequently Asked Questions

From the “Help” dropdown menu, users can view the application Frequently Asked Questions
screen by selecting the “Frequently Asked Questions” menu item.

2.4.7

Log Out

By clicking “Log Out,” the Guest User’s session ends and any temporarily saved information
(Recipes, Favorites) is cleared.

2.5

Tools

2.5.1

Exhibit A Grains Tool

The Exhibit A Grains Tool determines:
1. the ounce equivalent (oz eq) grains or grains/breads serving(s) for your grain product,
2. amount of a grain product to serve in order to provide a specific ounce equivalent (oz eq)
grains or grains/breads serving(s), and
3. amount of a grain product to serve in order to meet Minimum Grains Requirement as
appropriate for the specific age group/grade group.
Click the “Exhibit A Grains Tool” button on FBG main screen to access Exhibit A Grains Tool
functionality.
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Users can also access the functionality by selecting the “Exhibit A Grains Tool – My Products”
and “Exhibit A Grains Tool – Enter Product” menu items under Tools from the top navigation
bar.

NOTE: This functionality is available to Guest Users, but the Products will not be saved
and accessible once user’s session expires.
Selecting "Exhibit A Grains Tool - My Products" takes you to the Exhibit A Grains Tool – My
Products screen. Information about the tool can be accessed at the top of the screen by clicking
the gray heading bar to expand or collapse the text.

Click “Enter Exhibit A Product” button and the Exhibit A Grains Tool - Enter Product screen
will be displayed:
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Instructions about the tool can be accessed at the top of the screen by clicking the gray heading
bar to expand or collapse the text.
NOTE: The instruction steps correspond to the numbers listed next to the data entry
fields within the tool.
To save an Exhibit A Product, user must enter information in the Product Name header field, and
the Date field is optional. Press the Save button to save.

Exhibit A Grains Tool can perform calculations to determine the grains contribution in ounce
equivalent (oz eq) for SBP/NSLP/NSLP Afterschool Snack Service/CACFP/Preschool, or in
grains/breads servings for CACFP/SFSP/NSLP Afterschool Snack Service/Preschool. User
should select the applicable method:
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Only one food item from Exhibit A can be selected at a time. There is a search control that
allows the user to locate food items as listed in Exhibit A. Please refer to Exhibit A: Grain
Requirements For Child Nutrition Programs.

Users can search for food items (as listed in Exhibit A) by entering one or more keywords and
then pressing the Search button or hitting the Enter key. Once the food item has been located,
click the corresponding “Add” button to populate that food item into the Exhibit A Product.
The selected food item will appear in a table under the search results.
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To remove a food item from Exhibit A Product, use the corresponding “X” button.

For each food item added, the user can perform one or more of the following calculations:
1. Grains Contribution – calculate the ounce equivalent (oz eq) grains or grains/breads
servings for your grain product, and/or
2. Amount to Serve – calculate amount of a grain product to serve in order to provide a
specific ounce equivalent (oz eq) grains or specific grains/breads servings, and/or
3. Amount to Serve by Age Group/Grade Group – calculate amount of a grain product to
serve in order to meet Minimum Grains Requirement as appropriate for the specific age
group/grade groups you are serving.

2.5.1.1 Grains Contribution
The Grains Contribution tab calculates the ounce equivalent (oz eq) grains or grains/breads
servings for your grain product.
2.5.1.1.1. Groups A – G
For food items in Groups A-G, the user needs to enter a Serving Size (a positive number, for
example: 2, or 1.5) and select a Measurement Unit (grams or ounces), and then the Grains
Contribution is calculated. The Grains Contribution will be in ounce equivalent when Ounce
Equivalent (oz eq) Grains (SBP/NSLP/CACFP) Method is selected, and in grains/breads
servings when Grains/Breads Servings (CACFP/SFSP/NSLP Afterschool Snack Service)
Method is selected. You can change Method selection and Serving Size and Measurement Unit
values at any time, and the Grains Contribution will be recalculated accordingly.
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The Grains Contribution will also be listed in the crediting statement below the table.

2.5.1.1.2. Groups H and I – Ounce Equivalent Grains
For Ounce Equivalent Grains Method, when a food item in Group H or I is selected, the
Measurement Unit can be in cups in addition to grams and ounces. When “cup(s)” is selected,
the Weight or Cups of One Ounce Equivalent/Minimum Serving Size as Listed in Exhibit A
needs to be selected as well.
For food items in Group H, there is only one option currently available – “1/2 cup cooked”, so it
is pre-selected for the user.

For food items in Group I, three options are available for Weight or Cups of One Ounce
Equivalent/Minimum Serving Size as Listed in Exhibit A, so the user needs to make a selection.
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The Grains Contribution will be listed in the crediting statement below the table.

2.5.1.1.3. Groups H and I – Grains/Breads Serving(s)
For Grains/Breads Serving(s) Method, when a food item in Group H or I is selected, the
Measurement Unit can be in cups in addition to grams and ounces. When “cup(s)” is selected,
the Weight or Cups of One Ounce Equivalent/Minimum Serving Size as Listed in Exhibit A
needs to be selected as well.
For food items in Group H, there is only one option currently available – “1/2 cup cooked”, so it
is pre-selected for the user.

For food items in Group I, there is only one option currently available – “3/4 cup”, so it is preselected for the user.
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The Grains Contribution will be listed in the crediting statement below the table.

2.5.1.2 Amount to Serve
Amount to Serve tab calculates amount of a grains product to serve in order to provide a specific
ounce equivalent (oz eq) grains or specific grains/breads servings.
2.5.1.2.1. Groups A – G
For food items in Groups A-G, the user first needs to enter the Desired Grains Contribution (a
positive number, for example: 2, or 1.5). The Measurement Unit (ounce equivalent or
grains/breads servings) will be filled in automatically based in the Method selected. Then the
user needs to enter the Serving Size, as provided on Product Label (see more details below), and
the Amount to Serve is calculated. You can change the Method selection, the Desired Grains
Contribution and Serving Size values at any time, and the Amount to Serve will be recalculated
accordingly.
The Amount to Serve will also be listed in the Amount to Serve statement below the table.

The Serving Size (as provided on Product Label) column consist of two groups:
1. Serving Size: enter the amount (as provided
on Product Label), and then select the
measurement unit.
2. Weigh(s): enter the weight (positive number,
for example, 2 or 1.5), and then select the
measurement unit.
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The selection the user makes in the Serving Size Measurement Unit drop-down will determine
how the Amount to Serve will be displayed:
Table 5: Serving Size and Amount to Serve Measurement Unit

Serving Size Measurement Unit

Amount to Serve Measurement Unit Example

piece(s)/slice(s)

2.75 piece(s)/slice(s)

serving(s)

2.75 serving(s) ( 1.25 oz or 31.00 g )

single serve package(s)

2.75 single serve package(s)

2.5.1.2.2. Groups H and I
For food items in Group H and I, the user first needs to select a Food Item Type from the dropdown. In some cases, Food Item Type selection is fixed based on Exhibit A, and then the dropdown is not shown.
Then the user needs to enter the Desired Grains Contribution (a positive number, for example: 2,
or 1.5). The Measurement Unit (ounce equivalent or grains/breads servings) will be filled in
automatically based on the Method selected. The Amount to Serve is calculated automatically in
cups. You can change the Method selection and the Food Item Type and the Desired Grains
Contribution values at any time, and the Amount to Serve will be recalculated accordingly.
The Amount to Serve will also be listed in the Amount to Serve statement below the table.

2.5.1.3

Amount to Serve by Age Group/Grade Group

The Amount to Serve by Age Group/Grade Group tab calculates the amount of a grain product to
serve to meet the Minimum Grains Requirement for the specific age group/grade group you are
serving.
2.5.1.3.1. Groups A – G
For food items in Groups A-G, the user first needs to enter the Serving Size, as provided on
Product Label (see more details below) and select the Program – Meal combination from the
drop-down menu.
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The Amount to Serve to Meet Minimum Grains Requirement is calculated for each age
group/grade group corresponding to the Program – Meal combination selected. You can change
the Method selection, Serving Size values and Program – Meal combination at any time, and the
Amount to Serve will be recalculated accordingly.
The Amount to Serve to Meet Minimum Grains Requirement will be listed in the Amount to
Serve table.

The Serving Size (as provided on Product Label) column consist of two groups:
1. Serving Size: enter the amount (as provided
on Product Label), and then select the
measurement unit.
2. Weigh(s): enter the weight (positive number,
for example, 2 or 1.5), and then select the
measurement unit.

Food Buying Guide (FBG) – User Guide

December 11, 2020

Page 36

FNS User Manual - FBG
The selection the user makes in the Serving Size Measurement Unit drop-down will determine
how the Amount to Serve will be displayed:
Table 6: Serving Size and Amount to Serve Measurement Unit

Serving Size Measurement Unit

Amount to Serve Measurement Unit Example

piece(s)/slice(s)

2.75 piece(s)/slice(s)

serving(s)

2.75 serving(s) ( 1.25 oz or 31.00 g )

single serve package(s)

2.75 single serve package(s)

2.5.1.3.2. Groups H and I
For food items in Group H and I, the user first needs to select a Food Item Type from the dropdown. In some cases, Food Item Type selection is fixed based on Exhibit A, and then the dropdown is not shown.
Then the user needs to select the Program – Meal combination. The Amount to Serve is
calculated automatically in cups. You can change the Method selection, the Food Item Type and
the Program – Meal combination values at any time, and the Amount to Serve will be
recalculated accordingly.
The Amount to Serve will be listed in the Amount to Serve table.
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2.5.1.3.3. CACFP Infant Meal Pattern
Some Exhibit A food items are not creditable in the CACFP Infant meal pattern. For these noncreditable food items, when “CACFP – Infant” is selected in the Program – Meal drop-down, the
following statement will be displayed instead of the calculation results: “This food is NOT
creditable for CACFP Infant meal pattern.”

2.5.1.4 My Products
The “Back to List” button on the bottom of the screen takes user to the Exhibit A Grains Tool –
My Products screen.

NOTE: “Back to List” button does not save any information, so please be sure to save
any changes before pressing it.
Click on table headers to sort by that column’s value. Enter a search string into the Product
Name column’s search field to narrow selection of Exhibit A products displayed.
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Use the links in the Actions column for an existing Exhibit A Product:
•
•
•
•
•
•

2.5.2

Edit – to change or update information previously entered in an Exhibit A Product
Copy – to create a copy of an existing Exhibit A Product
Delete – to permanently remove an Exhibit A Product
PDF – to generate, view, and save a PDF of the Exhibit A Product
Text – to generate, view, and save Exhibit A Product as a text or Excel file
Email – to generate Exhibit A Product PDF and email it to one or more recipients.

FBG Calculator

The FBG Calculator is a tool that will create a shopping list to assist users in ordering food for
their programs based on food items needed and your current inventory. This tool contains series
of tabs with formulas for each food group.
Click the “FBG Calculator” button on FBG main screen to access FBG Calculator functionality.

Users can also access the functionality by selecting the “FBG Calculator – My Shopping Lists”
and “FBG Calculator – Create Shopping List“ menu items under the Tools.

NOTE: This functionality is available to Guest Users, but the Shopping Lists will
disappear once user’s session expires.
This takes you to the FBG Calculator – My Shopping Lists screen. Information about the tool
can be accessed at the top of the screen by clicking the gray FBG Calculator heading bar to
expand or collapse the text.
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Click “Create Shopping List” button and the FBG Calculator - Create Shopping List screen will
be displayed:

User must enter information in the Shopping List Name header field, and the Date field is
optional.

A Shopping List can include ingredient(s) for one or more meal components, and each meal
component has a separate tab in the Shopping List. Please note the Grains tab only reflects
search results for items listed in the Food Buying Guide yield table for Grains.

2.5.2.1 Adding Ingredients to a Shopping List
A Shopping List can include ingredient(s) for one or more meal components, and each meal
component has a separate tab in the Shopping List. Each tab has a search control that allows the
user to locate food items within that given meal component (ex. the Fruits tab’s search control
will locate only fruit items).
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Users can search for food item by entering one or more keywords. Once the food item has been
located, click the corresponding “Add” button to populate that food item into the Shopping List.
Users can also add ingredients to the Shopping List from their Favorites using the Display
Favorites button. Once Display Favorites button is pressed, the Search Results table is populated
with this user’s Favorite food items that are allowed to be used in a Shopping List for the Meal
Component selected.
Once a food item is selected, use the Add Serving Size button to add a row for one or more
serving sizes you need.
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The serving size rows will appear under the food item row.

Some of the food item information will be pre-populated from the Food Buying Guide. The user
needs to select one or more Serving Sizes and enter the Number of Servings for each serving
size. Exact Quantity and Need Purchase Units will calculate automatically. The total Servings
Count, Exact Quantity, and Buy Purchase Units for the food item will calculate automatically
and will be displayed in the food item row. The user can also enter Number of Purchase Units on
Hand in the food item row, it will be taken into account when the total Buy Purchase Units for a
food item is calculated.
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2.5.2.2 Shopping List
The Shopping List tab contains a summary shopping list for the users’ food items based on the
information entered by the user.

Use “Save” button to save your Shopping List at any point. Use “Back to List” button to return
to the FBG Calculator – My Shopping Lists screen.
NOTE: “Back to List” button does not save any information, so please be sure to save
any changes before pressing it.
Click on table headers to sort by that column’s value. Enter a search string into the Shopping
List Name column’s search field to narrow selection of shopping lists displayed.
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Use the links in the Actions column for an existing Shopping List:
•
•
•
•
•
•

2.5.3

Edit – to change or update information previously entered in a Shopping List
Copy – to create a copy of an existing Shopping List
Delete – to permanently remove a Shopping List
PDF – to generate, view, and save a PDF of the Shopping List
Text – to generate, view, and save Shopping List as a text or Excel file
Email – to generate Shopping List PDF and email it to one or more recipients.

Determining Creditable Grains/Breads

The Interactive Flow Chart for Determining Creditable Grains/Breads is a questionnaire that
opens in a pop-up window.
The user is asked to provide Yes or No responses to a series of questions. After each answer is
provided, the interactive chart either displays the next question, or arrives to the final answer.
Use Back button to go back one question. Use the Start Over button to start over. Use the Close
button to close the pop-up window.
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2.5.4

Does My Product Meet the Whole Grain-Rich Criteria

The Interactive Flow Chart to Determine If a Product Meets the Whole Grain-Rich Criteria is a
questionnaire that opens in a pop-up window.
The user is asked to provide Yes or No responses to a series of questions. After each answer is
provided, the interactive chart either displays the next question, or arrives to the final answer.
Use Back button to go back one question. Use the Start Over button to start over. Use the Close
button to close the pop-up window.

2.6

Exporting Data to Microsoft Excel

Throughout the FBG application, there are “Export” buttons that allow to export data displayed
on the screen as a text file delimited by “|” character, that can be imported into Microsoft Excel.
Follow the steps below to open the text file in Microsoft Excel.

2.6.1

For a Microsoft Windows Computer

1. Click on Export button and save the file to your computer, noting the file name and
directory (for example, FoodItem.txt in your Downloads directory)
2. Open Microsoft Excel
3. Go to “File” menu and click on the “Open” option
4. In the “Open” dialog, navigate to the directory where you downloaded the file and select
“All Files” in the drop-down – so the .txt file is displayed:
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5. Click on the file and press the “Open” button
6. In the “Text Import Wizard – Step 1 of 3” dialog, select the “Delimited” radio button,
then press the “Next” button:
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7. In the “Text Import Wizard – Step 2 of 3” dialog, in the “Delimiters” section, uncheck
the “Tab” option, check the “Other” option and enter the “|” character into the text field
next to it, then press the “Next” button:

8. Optional: in the “Text Import Wizard – Step 3 of 3” dialog, click on each column in the
“Data preview” section and then select the “Text” option in the “Column data format”
section, changing the columns’ type to Text one by one.
9. In the “Text Import Wizard – Step 3 of 3” dialog, press the “Finish” button:

10. The file will open in Microsoft Excel
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2.6.2

For an Apple Mac Computer

1. Click on Export button and save the file to your computer, noting the file name and
directory (for example, FoodItem.txt in your Downloads directory)
2. Open Microsoft Excel
3. Go to “File” menu and click on the “Open” option
4. In the “Open” dialog, select the “Open” icon in the left sidebar, then select “On my
Mac”. An Open panel will now display. Navigate to the directory where you
downloaded the file so the .txt file is displayed
5. Click on the file and press the “Open” button
6. In the “Text Import Wizard – Step 1 of 3” dialog, select the “Delimited” radio button,
then press the “Next” button
7. In the “Text Import Wizard – Step 2 of 3” dialog, in the “Delimiters” section, uncheck
the “Tab” option, check the “Other” option and enter the “|” character into the text field
next to it, then press the “Next” button
8. Optional: in the “Text Import Wizard – Step 3 of 3” dialog, click on each column in the
“Data preview” section and then select the “Text” option in the “Column data format”
section, changing the columns’ type to Text one by one.
9. In the “Text Import Wizard – Step 3 of 3” dialog, press the “Finish” button
10. The file will open in Microsoft Excel
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3

Registered User

Registered Users can use all site functionality in the same manner as outlined for Guest Users in
section 2. Additional features for registered users include:
1. Items saved to Favorites will be retained for the Registered User.
2. FBG Calculator Shopping Lists will be retained for the Registered User.
3. Recipe Analysis Workbook is available to Registered Users with Organizations other
than Vendor.
4. Product Formulation Statement is available to Registered Users with Organization set to
FNS National Office, FNS Regional Office, and Vendor.

3.1

Logging In

When navigating to the FBG URL, a User will first see the following Login Screen:
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3.1.1

Requirement – Level 1 USDA eAuthentication Account

A Level 1 USDA eAuthentication account is needed to access the tool as a registered user.
To create a new Level 1 USDA eAuthentication account, follow the instructions available inside
the box as shown on the screenshot below. The link provided on screen will take you directly to
register for a new Level 1 eAuthentication account.

3.1.2

Logging In with eAuth

When navigating to the FBG URL, a User will first see the login screen. Users who have a
Level 1 USDA eAuthentication account can proceed to the site by clicking on the “Login or
Create Profile” button.
The “Login or Create a Profile” button will direct the user to the eAuthentication login screen to
enter his/her eAuthentication credentials.
If the user has not used the Food Buying Guide application before, he will be prompted to create
a user profile as described in section 3.1.3.
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3.1.3

New FBG Users – Create a User Profile

The user will be prompted to create a user profile when first accessing the FBG tool as an
authenticated user. Name and email fields will be automatically pre-populated with information
tied to the user’s eAuthentication account, so these fields will be grayed out and will not be
editable.
The other required field is the Organization Type and the user will need to select one of the
following options: FNS National Office, FNS Regional Office, Vendor, State Agency, School,
Child Care, or Other. If Vendor or Other is selected, the user will be prompted to enter an
Organization Name. Vendors will also have the capability to include a company profile and upload
company letterhead to be used for the Product Formulation Statement.

3.2

Tools

3.2.1

Recipe Analysis Workbook (RAW)

The Recipe Analysis Workbook, or RAW, is a tool available to Registered Users affiliated with
an Organization Type other than Vendor.
The Recipe Analysis Workbook (RAW) is a tool to help you determine your recipes' expected
meal pattern contributions. This tool contains series of tabs with formulas for each food group.
The RAW is not a tool to evaluate dietary specifications for calories, sodium, and saturated fat. It
also cannot determine whether the serving size information entered is correct for crediting.
Click the “Recipe Analysis Workbook (RAW)” button.

NOTE: This functionality is only available to Authenticated Users who have selected
Organization other than “Vendor.”
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Users can also access the functionality by selecting the “My RAW Recipe List” and “Create
RAW” menu items under the Tools menu. The “Manage My RAW Folders” menu allows the
users to manage a set of folders the RAW are assigned to – see section 3.2.1.1 for more
information.

This takes you to the Recipe Analysis Workbook (RAW) screen. Information about the tool can
be accessed at the top of the screen by clicking the gray Recipe Analysis Workbook (RAW)
heading bar to expand or collapse the text.
Click on table headers to sort by that column’s value. Enter a search string into the Folder,
Recipe Name, and Recipe Number column’s search fields to narrow selection of RAW
displayed.
Use the links in the Actions column for an existing RAW:
•
•
•
•
•
•

Edit – to change or update information previously entered in RAW document
Copy – to create a copy of an existing RAW document
Delete – to permanently remove RAW document
PDF – to generate, view, and save a PDF of the RAW
Text – to generate, view, and save Meal Pattern Contribution of the RAW as a text or
Excel file
Email – to generate RAW PDF and email it to one or more recipients.

Click “Create Recipe Analysis Workbook” button and the Create Recipe Analysis Workbook
(RAW) screen will be displayed:
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Information about the tool can be accessed at the top of the screen by clicking the gray
Instructions heading bar to expand or collapse the text.
User must enter information in all the required RAW header fields (Recipe Name, Recipe
Number, Servings per Recipe, and Serving Size for the RAW).
User can also select a Folder to place the RAW into, and create a new Folder using the Add
Folder button – see section 3.2.1.1 for more information.

A RAW can include ingredient(s) for one or more meal components, and each meal component
has a separate tab in the RAW.
Please note there are three methods to calculate meal pattern contribution for grains:
•
•
•

Method A – based on Exhibit A – Go to this tab to search and select ingredients from
Exhibit A
Method B – based on Food Buying Guide – This tab will automatically populate if food
ingredients are selected from the search below.
Method C – based on Grams of Creditable Grains – Go to this tab to manually enter grain
ingredients.
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3.2.1.1

Managing RAW Folders

To view existing RAW Folders on “Manage Folders” screen and edit information for a folder,
use the “Manage my RAW Folders” menu item under the Tools menu. To add a new food item,
press the “Create New Folder” button.

On the “Create Folder” screen, fill in the folder name in the Folder field and press the “Create
Folder” button to save. Press the “Cancel” button to cancel and return to the “Manage Folders”
screen.

To edit the name of an existing folder, click on the “Edit” link in the Actions column. To delete
folder, click on the corresponding “Delete” link.
NOTE: Folders can be deleted only if there are no RAWs assigned to them.

All user’s existing folders will be displayed in the Folder drop-down on Create and Edit RAW
pages. RAW Folders can also be created using the “Add Folder” button on Create and Edit RAW
pages.
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The “Add Folder” button brings up the “Create New Folder” pop-up dialog.

Enter a unique folder name and press “Create Folder” button to save. Press “Cancel” button to
cancel.
3.2.1.2 Food Items in Vegetables, Fruits, Meats/MA, and Grains – Method B
The Select Creditable Ingredient tab has search controls that allow the user to locate food items
within Vegetables, Fruits, Meats/Meat Alternatives, and Grains (used for Method B crediting).
Search and select only the recipe food ingredients that contribute to the meal pattern. It is
important to select the correct form of the ingredient (fresh, frozen, etc.) from the Food Buying
Guide (FBG). If an exact match is not available, choose a food item in the FBG that closely
matches your recipe ingredient.
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Users can search for food item by entering one or more keywords, and/or selecting a Meal
Component and/or Category. Search results are displayed in a table, paginated. Once the food
item has been located, click the corresponding “Add” button to populate that food item into the
RAW.
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Users can also add ingredients to the RAW from their Favorites using the Display Favorites
button. Once Display Favorites button is pressed, the Search Results table is populated with this
user’s Favorite food items that can be used in a RAW.
Once a food item has been added, if it is no longer needed, the users can use the corresponding
“Remove” button to remove the food item from the list of ingredients.
Once the ingredients have been added, they can be viewed on the corresponding tabs of the
RAW. Some of the food item information will be pre-populated from the Food Buying Guide
(such as the Purchase Unit); some of the pre-populated information will be editable. The user
may edit certain fields if s necessary. The Calculated Quantity to Purchase will calculate
automatically for each food item once Quantity of Ingredient (required) and Preparation Yield
(optional) have been entered.
Enter quantity of ingredient in the same unit as the Purchase Unit. If the recipe lists the
ingredients in a different unit, you will need to convert the quantity to match the FBG. For
example, convert ingredients measured in ounces to their decimal equivalent of a pound. See
Table 5 Decimal Weight Equivalents.
Record the yield factor in “Preparation Yield factor found in the “Additional Information”
Column for any ingredients that need to be converted to match the form of the item as listed
under “Food as Purchased, AP” Column.

Total Vegetable Amount will be calculated as the ingredients’ data is entered and automatically
displayed on the bottom of Vegetables tab.
For Vegetables only, if there are "leftover" (under 1/8 cup) amounts in any of the vegetable
categories, the leftover amount is carried over to (included into) the Additional Vegetables
category total, then round down.
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Display of information on Vegetables, Fruits, Meats/Meat Alternates, and Grains – Method B
tabs is very similar with minor differences. Vegetables tab displays food items separated by
vegetable sub-group while on other tabs food items are displayed together; Grains – Method B
tab does not have the Preparation Yield controls.

3.2.1.3 Grains – Method A
Grains – Method A tab is based on food items found in Exhibit A. It has a search control that
allows the user to locate food items within Exhibit A.

Users can search for food item by entering one or more keywords. Once the food item has been
located, click the corresponding “Add” button to populate that food item into the RAW.
Only Product Description will be pre-populated from the Exhibit A, and the user will need to edit
the other fields.
For food items in Groups A-G, enter Quantity of Product and Weight of One Unit, and proceed
to select the appropriate Measurement Unit (oz. or gm) from the drop-down menu. The Quantity
of Product in Ounces and the Weight of One Ounce Equivalent as listed in Exhibit A will auto
calculate/populate.
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For food items in Groups H-I, enter Quantity of Product, select the appropriate Measurement
Unit (oz., gm., or cup(s), and proceed to select the Weight or Cups of One Ounce Equivalent as
listed in Exhibit A from the drop-down menu.

Meal Pattern Contribution value will calculate automatically as all appropriate fields are filled in.
If a food item is not needed the users can use the corresponding “X” button to remove the food
item from the list of ingredients.

3.2.1.4 Grains – Method C
Grains – Method C tab is based on grains food items entered manually. You can add food items
using “Add New Ingredient” button.

Enter the description of creditable grain ingredient and quantity of ingredient, then select the
measurement unit. The Meal Pattern Contribution value will calculate automatically.
If a food item is not needed the users can use the corresponding “X” button to remove the food
item from the list of ingredients.

Food Buying Guide (FBG) – User Guide

December 11, 2020

Page 59

FNS User Manual - FBG

3.2.1.5 Meal Pattern Contribution Statement
The Meal Pattern Contribution tab of the RAW contains a generated meal patterns contribution
statement for the product based on the information entered by the user.
NOTE: You must enter Serving Size per Recipe and Serving Size for your RAW for
Meal Pattern Contribution tab to populate correctly.

3.2.1.6 Recipe Notes
Use the Recipe Notes tab of the RAW to enter notes.
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Use “Save” button at the bottom of the Create/Edit RAW screen to save your RAW at any point.
Use “Back to RAW List” button to return to the RAW List screen.
NOTE: “Back to RAW List” button does not save any information, so please be sure to
save any changes before pressing it.

3.2.2

Product Formulation Statement (PFS)

The Product Formulation Statement, or PFS, is a tool available to Registered Users affiliated
with an Organization Type of Vendor, FNS National Office, and FNS Regional Office.
Click the “Product Formulation Statement (PFS)” button on FBG main screen to access Product
Formulation Statement functionality.

NOTE: This functionality is only available to Authenticated Users who have selected
Organization of “Vendor,” “FNS National Office,” or “FNS Regional Office.”
Users can also access the functionality by selecting the “My PFS List”, “Create PFS for School
Meals” and “Create PFS for Other CN Programs“ menu items under the Tools.

Food Buying Guide (FBG) – User Guide

December 11, 2020

Page 61

FNS User Manual - FBG
Click “Create PFS for School Meals” or “Create PFS for Other CN Programs (CACFP, SFP)”
button to create the corresponding type of the PFS.

Click on table headers to sort by that column’s value. Enter a search string into the Product
Name, CN Program, and Product Code column’s search fields to narrow selection of PFS
displayed.
Use the links in the Actions column for an existing PFS:
•
•
•
•
•
•
•

Edit – to change or update information previously entered in PFS document
Copy – to create a copy of an existing PFS document
Delete – permanently remove PFS document
Text – to generate, view, and save Meal Pattern Contribution Statement of the PFS as a
text or Excel file
PDF – generate, view, and save a PDF of the PFS
Email – email a PDF format of the PFS document to one or more email addresses

Click “Create PFS for School Meals” or “Create PFS for Other CN Programs (CACFP, SFP)”
button and Create School Meals PFS of Create PFS for Other CN Programs (CACFP, SFP)
screen will be displayed:

User must enter information in all the required PFS header fields (Product Name, Product Code,
Serving Size, and Date for the PFS).
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3.2.2.1 Adding Ingredients to a PFS
A PFS can include ingredient(s) for one or more meal components, and each meal component
has a separate tab in the PFS. Each tab has a search control that allows the user to locate food
items within that given meal component (ex. the Fruit tab’s search control will locate only fruit
items).
NOTE: Food Items for Further Processing will appear in searches in Meats/Meat
Alternates and Vegetables tabs.

Users can search for food item by entering one or more keywords. Once the food item has been
located, click the corresponding “Add” button to populate that food item into the PFS.
Users can also add ingredients to the PFS from their Favorites using the Display Favorites
button. Once Display Favorites button is pressed, the Search Results table is populated with this
user’s Favorite food items that can be used in a PFS for the Meal Component selected.

Some of the food item information will be pre-populated from the Food Buying Guide; some of
the pre-populated information (such as the Purchase Unit) will be editable. The user may edit
certain fields if s necessary. The Creditable Amount will calculate automatically.
If a food item is not needed the users can use the corresponding “X” button to remove the food
item from the list of ingredients.
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Display of “Creditable Amount” differs per meal component tab as follows:
•

•

•
•
•

Meats/Meat Alternates tab contains three separate tables for Meats, Meat Alternates, and
Alternate Protein Product. Meats and Meat Alternates food should be located using
search, APP should be entered manually. Creditable Amount totals are displayed per food
item, per table, and grand total.
Vegetables tab – food items should be located using search. Creditable Amount totals are
displayed per food item; for School PFS – per vegetable sub-group; for Other PFS – the
grand total.
Fruits tab – food items should be located using search. Creditable Amount totals are
displayed per food item and grand total.
Grains Based on Exhibit A tab – food items should be located using search. Creditable
Amount totals are displayed per food item and grand total.
Grains Based on Grams of Creditable Grains tab – food ingredient must be entered
manually, and the user must select the appropriate group within Exhibit A that represents
the end product. For example, if the user is making whole wheat bread and enters whole
wheat flour as the food ingredient, then Exhibit A group B should be selected, since
whole wheat bread is the end product. A link to Exhibit A is available for reference to
assist in guiding you to select the appropriate group. Creditable Amount totals are
displayed per food item and grand total.

3.2.2.2 Meal Pattern Contribution Statement
The Meal Pattern Contribution Statement tab of the PFS contains a generated meal patterns
contribution statement for the manufacturer’s product based on the information entered by the
user.
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Use “Save” button to save your PFS at any point. Use “Back to PFS List” button to return to the
PFS List screen.
NOTE: “Back to PFS List” button does not save any information, so please be sure to
save any changes before pressing it.

3.3

Top Navigation Menus

In addition to navigating through FBG from the main screen, users can use the Top Navigation
menus to access functionality within the site. Please refer to section 2.4 for more details on the
Navigation menus available to the user. In addition to the menus already discussed in section 2.4,
registered users will see the following:

3.3.1

User Greeting

User’s name, as entered for the user profile, will be displayed in the “Welcome” FBG menu.

3.3.2

My Profile

Use “My Profile” under “Welcome” menu to view and edit your profile information.
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3.3.2.1

Manage User Profile

On the View User Profile screen, you can view information that was previously entered or use
“Edit” button to edit information found in the profile. The users can make any desired changes
and then click on the “Save” button. The “Cancel” button returns the user to his/her profile.

3.3.2.2 Manage Company Profile
Users with Vendor selected as the Organization type will be prompted to enter their company
information. Company Profile information will be displayed on View User Profile screen under
user profile information section. It can be edited along with user’s profile information as
described above.
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3.3.3

Log Out

By clicking “Log Out,” the Authenticated User’s session ends. Any saved information (Recipes,
Favorites, PFS) is stored for later availability.
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